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About This Book
About the Author

Kevin Siegel is the founder and president of IconLogic, 
Inc. He has written more than 100 step-by-step 
computer training books, including Essentials of Adobe 
Captivate 5, Essentials of Adobe Captivate 4, Adobe 
Captivate 4: Beyond the Essentials, Essentials of Adobe 
Captivate 3, Essentials of Adobe Captivate 2, Essentials 
of Macromedia Captivate, Essentials of RoboDemo 5, 
Essentials of Adobe RoboHelp 8, Essentials of Adobe 

RoboHelp 7, Essentials of Adobe Dreamweaver CS3, QuarkXPress 8: The Basics, 
Essentials of Adobe InDesign CS3, Camtasia Studio 7: The Essentials and 
Camtasia Studio 6: The Essentials.

Kevin spent five years in the U.S. Coast Guard as an award-winning 
photojournalist and has more than two decades experience as a print publisher, 
technical writer, instructional designer and eLearning developer. He is a certified 
technical trainer, has been a classroom instructor for more than 20 years and is a 
frequent speaker at trade shows and conventions. Kevin holds multiple 
certifications from companies such as Adobe and the CompTIA. You can reach 
Kevin at ksiegel@iconlogic.com.

About IconLogic Books
IconLogic books are unique! They are created by instructors with years of 
software training experience. Before IconLogic books, our instructors rarely 
found a book that was perfect for a classroom setting. If the book was beautiful, 
odds were that the text was too small to read and hard to follow. If the text in a 
book was the right size, the quality of exercises left something to be desired. 

Finally tiring of using inadequate materials, our instructors started teaching 
without any books at all. Over the years, we’ve had many students ask if the in-
class instruction came from a book. If so, they said they’d buy the book. That 
sparked an idea. We asked students—just like you—what they wanted in a 
training manual. You responded, and the results appear in this book. 

We hope you enjoy the book. If you have any comments or questions, please see 
page ix for our contact information.
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Book Conventions
This book has been divided into several modules. Because each module builds on 
lessons learned in the previous module, we recommend that you complete each 
module in succession. During every module, you will be guided through lessons 
step by step. Instructions for you to follow will look like this:

 instructions for you to follow will look like this

If you are expected to type anything or if something is important, it will be set in 
bold type like this:

 type 9 in the box

When asked to press a key on your keyboard, the instruction will look like this:

 press [shift]

Confidence Check
You will also come across the little guy at the right. He indicates 
a Confidence Check. Throughout each module you will be guided 
through hands-on exercises. But at some point, you’ll have to 
fend for yourself. That is where Confidence Checks come in. 
They’re very important. You must be sure to complete each of 
them because some exercises build on completed Confidence 
Checks.

System Requirements 
The Adobe Captivate 5 software does not come with this book. The software can be 
purchased directly from Adobe (http://www.adobe.com). You can also download 
a trial version of Captivate from Adobe. There are no limitations on the trial, and it 
will last for 30 days from the day you install it on your computer. Here are Adobe’s 
system requirements for installing and using Captivate 5.

Windows: Adobe Captivate 5, 1GHz or faster processor, Intel Pentium 4, Intel 
Centrino, Intel Xeon, or Intel Core Duo (or compatible) processor, Microsoft 
Windows XP with Service Pack 2 (Service Pack 3 recommended); Windows Vista 
Home Premium, Business, Ultimate, or Enterprise with Service Pack 1; or Windows 
7, 1GB minimum RAM (2GB recommended), 3GB of available hard-disk space for 
installation; additional free space required during installation (cannot install on 
flash-based storage devices), DVD-ROM drive, 1,024x576 display (1,280x1024 is 
recommended) with 16-bit video card, Broadband Internet connection required for 
online services. 

Mac: Adobe Captivate 5, Multicore Intel processor, Mac OS X v10.5.7 or v10.6, 1GB 
minimum RAM (2GB recommended), 3GB of available hard-disk space for 
installation; additional free space required during installation (cannot install on a 
volume that uses a case-sensitive file system or on flash-based storage devices), 
DVD-ROM drive, 1,024x576 display (1,280x1024 is recommended) with 16-bit video 
card, Broadband Internet connection required for online services.

You will also need Microsoft Office 2003 or newer on your computer. PowerPoint is 
used during activities beginning on page 24. If PowerPoint 2003 or newer is not 
installed, you will not be able to complete all of the activities.
© 1994-2010, IconLogic. All Rights Reserved.



 About This Book > Acrobat.com and Data Files
Acrobat.com and Data Files
Acrobat.com
Acrobat.com is a suite of free applications from Adobe that allows you to create, 
store and share documents and PDF files over the Web. You will need a free account 
with Acrobat.com to complete some of the activities in this book (the first activity 
appears on page 9 and there is another on page 136). Go to www.acrobat.com 
and set up an account now.

Windows and Mac Data Files
The data files that support the lessons presented in this book can be downloaded 
from the IconLogic website. If you are using Windows, complete the activity below. 
Mac users, complete the activity on the next page.

Student Activity: Download the Windows Data Files
1. Download the student data files necessary to complete the lessons presented in 

this book.

 start a web browser and go to the following web address: 
www.iconlogic.com/pc.htm

 click the Captivate 5: Beyond the Essentials link

Note: If the address above isn’t working or is running slowly, the data files for 
this book (it’s an EXE) can also be downloaded from our backup data files server 
located at the web address below.

http://files.me.com/iconlogic/ojlhap

On most browsers, a dialog box will appear asking if you want to Save, Run or 
Open the file.

 click the Save button, and save the file to your desktop

2. After the file downloads, close the web browser. 

3. Extract the data files.

 find the Captivate5BeyondEssentialsData.exe file you just downloaded to 
your desktop and then double-click the file to open it

The file is an EXE file containing the zipped data files. You will likely receive a 
security message when you open the file. If so, click the Run button.

 confirm C:\ appears in the Unzip to Folder area
 click the Unzip button and then click the OK button
 click the Close button after the files have been extracted to your hard drive

The data files you will need for this book have now been installed to your hard 
drive (within a folder named Captivate5BeyondEssentialsData). As you 
move through the lessons in this book, you will be working with these files.

The next activity is only for Mac users.
© 1994-2010, IconLogic. All Rights Reserved. vii
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Student Activity: Download the Mac Data Files
1. Download the student data files necessary to complete the lessons presented in 

this book.

 start a web browser
 go to the following web address: http://www.iconlogic.com/mac.htm
 click the Captivate 5: Beyond the Essentials link

The zipped data files will be downloaded to your Downloads folder and 
automatically extracted into a folder.

Note: If the address above isn’t working or is running slowly, the data files for 
this book (a zip file) can also be downloaded from our backup data files server 
located at the web address below.

http://files.me.com/iconlogic/67v59j

2. Move the data files folder to your desktop.

 drag the Captivate5BeyondEssentialsData folder from the Downloads 
folder to your desktop

3. You can now close the Downloads folder and the web browser. 
© 1994-2010, IconLogic. All Rights Reserved.



 About This Book > Need More Books?
Need More Books?
We are proud to offer books on the following subjects:

Editing and Grammar

Abrams’ Guide to Grammar: Second Edition

Editing With MS Word 2007

eLearning

Adobe Captivate versions 4 through 5

Techsmith Camtasia Studio versions 6 through 7

Help Authoring

Adobe RoboHelp HTML versions 6 through 8

PowerPoint

Microsoft PowerPoint 2008: The Essentials (for Mac)

Microsoft PowerPoint 2007: The Essentials (for Windows)

 
Contact Information and Ordering
IconLogic, Inc. 
3320 Breckenridge Way | Riva, MD  21140 | 410.956.4949 
Web: www.iconlogic.com | Email: orders@iconlogic.com
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Special Thanks
I’d like to thank Lori Smith for her contributions to this book. Lori wrote the activities 
on Actions that you will find beginning on page 163. 

Lori is IconLogic's lead programmer and an Adobe Certified Expert (ACE) in Adobe 
Captivate. Lori has a bachelor’s degree in electrical engineering from MIT, as well as 
a master’s in electrical engineering from George Mason University. She has been 
working in the field of software engineering for more than 20 years. During that time 
she worked on embedded software systems at Raytheon (E-Systems) and ARINC.
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Rank Your Skills
Before starting this book, complete the skills assessment on the next 
page.



How this assessment works
Below you will find 10 course objectives for Adobe Captivate 5: Beyond the Essentials. Before 
starting the book: Review each objective and rank your skills using the scale next to each 
objective. A rank of  means No Confidence in the skill. A rank of  means Total 
Confidence. After you’ve completed this assessment, go through the entire book. After 
finishing the book: Review each objective and rank your skills now that you’ve completed 
the book. Most people see dramatic improvements in the second assessment after completing 
the lessons in this book. 

Before-Class Skills Assessment
1. I can edit a Text Capture Template.     

2. I can create a Slide Group.     

3. I can aggregate published SWFs.     

4. I can create Question Pools.     

5. I can add Accessibility Text to slides.     

6. I can create a background mask.     

7. I can create a User Variable.     

8. I can create a Master Slide.     

9. I can create a Conditional Action.     

10. I can create a Manifest File.     

After-Class Skills Assessment
1. I can edit a Text Capture Template.     

2. I can create a Slide Group.     

3. I can aggregate published SWFs.     

4. I can create Question Pools.     

5. I can add Accessibility Text to slides.     

6. I can create a background mask.     

7. I can create a User Variable.     

8. I can create a Master Slide.     

9. I can create a Conditional Action.     

10. I can create a Manifest File.     

IconLogic, Inc.
3320 Breckenridge Way, Riva, MD  21140

www.iconlogic.com

Adobe Captivate 5 Skills Assessment
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Module 1: Essential Skills 
With a Twist
In This Module You Will Learn About:

• Planning eLearning Projects, page 3

• The Development Process, page 4

• Resolution and Recording Size, page 7

• Custom Recordings, page 14

• Text Caption Pre-Editing, page 18

And You Will Learn To:
• Rehearse a Script, page 9

• Edit Captivate’s Preferences, page 11

• Set Recording Keys, page 13

• Record a Custom Simulation, page 14

• Edit a Text Capture Template, page 18



Adobe Captivate 5: Beyond the Essentials
To Review or Not to Review...
I’ve created this book as a companion to my Adobe Captivate 5: The Essentials book 
that I released in mid-2010. During the writing of that book, my goal was to get you 
up and running using Captivate 5 as quickly as possible. The finished book tipped the 
scales at over 200 pages. After completing that book, readers had a fair grasp of how 
both to record and produce eLearning lessons using Adobe Captivate.

However, there was a ton of stuff that just wouldn’t fit into that book, nor was it 
appropriate to include many of those lessons into a beginner, or essentials, book.

In this book, I’m going to teach you many of the features and functions that I wasn’t 
able to cover in the Adobe Captivate 5: The Essentials book. But where to start? My 
assumption is, that if you’ve purchased this book, you already have most of the 
essential Captivate skills under your belt. But that could be a very bad assumption. 
Maybe you’ve forgotten all of the cool stuff I taught you in that book. Maybe you’ve 
taught yourself Captivate and have skipped the Adobe Captivate 5: The Essentials 
book and have started with this book.

Again, I’ve got to ask the question: where do I start? Instead of jamming the 
advanced concepts down your throat, let’s spend some time reviewing the essential 
information about Adobe Captivate, the production process and use Captivate to 
record a video or two.

Some of the information you are about to read in this first module is taken directly 
from the first few modules in my essentials book, where I made a concerted effort to 
get you comfortable with the Captivate interface and recording modes.

Before you skip ahead to the second module, I urge you to read through this module 
and complete the activities... it will be well worth your time (especially when you get 
to the last few activities in the module, where I teach you how to pre-edit the text 
captions created when you record a lesson... something that was not taught in the 
Adobe Captivate 5: The Essentials book).

What Is Adobe Captivate?
Using Adobe Captivate, you can create eLearning lessons from just about anything 
you can access from your computer. The lessons you create can be interactive—you 
can add captions, rollovers, slidelets, clickable areas, typing areas, animation, Flash 
Video, widgets, variables, sound effects and more. 

Captivate projects can be published as Small Web Format (SWF) files, executable 
files, Word documents and PDFs. The published SWFs will be cross-platform, 
meaning they can be viewed on just about any computer platform via a web browser 
(such as FireFox, Internet Explorer, Safari or Chrome).
2 © 1994-2010, IconLogic, Inc. All Rights Reserved.
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Planning eLearning Projects
eLearning lessons you create with Captivate can be as interactive as you design them 
to be. However, just because you can create technically solid Captivate lessons does 
not necessarily mean those lessons are effective learning vehicles. If you want to 
create good, useful projects, you have to plan ahead. Before starting Captivate and 
recording your first lesson, you should ask yourself the following questions:

 Who is my audience?

 What do I want my lessons to teach my audience?

 Is my audience multi-generational?

 Is my audience educated?

 Is my audience hearing challenged?

 Do I want my projects to contain images and background music? If so, 
where will I get them?

 Will there be captions (written instructions and descriptions)? If so, who will 
provide or write the captions?

 Will I use a storyboard or script? (Storyboards are rough sketches that 
show the general content of your project, slide by slide. If your projects 
contain more screen shots of an application than captions, a storyboard is a 
good idea. Scripts, which are detailed step-by-step procedures, are ideal if 
your project will contain a significant number of captions.) 

 Do I want my projects to be demonstrations, assessments or a combination 
of both?

When planning projects, keep in mind that the most useful projects contain the 
following basic elements:

 Title slide (telling the audience what they are going to learn)

 Credits and Copyright slide

 Narration, music and other sound effects

 Images and animations

 Interactivity (click boxes, text entry boxes and buttons)

 An ending slide (reviewing what the audience learned)
© 1994-2010, IconLogic, Inc. All Rights Reserved. 3
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The Development Process
I agree with people who say that Captivate seems to be an easy program to learn 
and use. Compared with programs like Adobe Photoshop or Flash, learning to use the 
essential tools you’ll find in Captivate is easy. However, there’s a whole development 
process you need to go through if you intend to produce effective eLearning, and 
mastering Captivate is only part of that process. Getting a handle on the eLearning 
development process isn’t easy. It takes a lot of practice, experience and, above all, 
patience.

I’ve listed the typical eLearning development process below. This list includes a skill 
level number indicating the level of difficulty for each task. The numbers go from 1 to 
10, with 10 indicating the most difficult task.

 Write It: If you’re not a writer, you’ll need someone to write the step-by-
step instructions (also known as a script or storyboard) necessary to record 
the project in Captivate. You’ll typically find technical writers doing this kind 
of work, and I consider this the most important process. Without a good 
script, you don’t have a movie. Think I’m kidding? What do Battlefield 
Earth, Barb Wire, Godzilla, Heaven’s Gate, Popeye and Ishtar have in 
common? (Skill Level: 10)

 Rehearse It: Take the completed script and go through it with the 
software you’ll be recording in front of you. Don’t skip any steps. You’ll be 
able to see if the written steps are incomplete or inaccurate before you 
attempt to record the movie in Captivate. (Skill Level: 2)

 Reset It: After rehearsing the steps, be sure to “undo” everything you did. 
Few things are more frustrating than recording your movie only to find a 
step you intend to demonstrate has already been performed.  
(Skill Level: 1)

 Record It: If rehearsals went well, the recording process should as well.  
(Skill Level: 1)

 Clean It: This is where you use Captivate to add highlight boxes, captions, 
text entry fields, buttons, click boxes, animation, question slides, audio, 
etc. If the project is large and each slide needs your attention, you should 
budget 7-10 hours to get the project “cleaned.” (Skill Level: 8)

 Publish It: While not a difficult task, if your project is large, this could take 
a great deal of time. You cannot do any work in Captivate while your 
project is publishing. (Skill Level: 1)

 Post It: This is a broad category. Posting your project will mean different 
things, depending on where your finished lessons are supposed to go. For 
instance, if your lessons are supposed to end up inside a Learning 
Management System (LMS), you will have to set up the reporting features 
for your project, publish the project and then upload or install it into the 
LMS. After the lesson has been uploaded, you will need to test the lesson to 
ensure that it scores as expected. If you plan to simply add the lessons to 
your website, Posting may be as simple as using Captivate’s FTP feature to 
upload the published files to your web server. (Skill Level: 2 or 3... or 
higher if your LMS is difficult to use)
4 © 1994-2010, IconLogic, Inc. All Rights Reserved.
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 Test It/Review It: This task isn’t difficult, but it could take time. If you 
find a problem, you’ve got to go back and clean it, publish it and retest it. 
I’d also encourage you to have team members access the lesson and test it. 
The more eyes on the lesson, the better. Some people argue that this step 
belongs above the Publish It process. I cannot argue with that logic. 
However, after testing the project, you’ll still need to Publish it and, as I 
mentioned above, if you’re working with an LMS, upload it and test again. 
Maybe it should be Test It, Publish It, Test It. See how easy I am? (Skill 
Level: 2)

 Republish, Repost, Retest: If something didn’t work when you tested the 
posted version of your lesson, you’ll have to return to Captivate and fix the 
problem. After that, you’ll Publish, Post and Test again. While this may not 
be a difficult process, it could take time. (Skill Level: 2 or 3... or higher if 
you can’t resolve the problem)

Budgeting Considerations
Many new Captivate developers underestimate development time needed to produce 
projects. The following table should help.

Project Size Number of Development Hours
Small Projects (1-25 slides) 1-4 hours of production
Medium Projects (26-75 slides) 4-7 hours of production
Large Projects (80-150 slides) 8-10 hours of production
Bloated Projects (more than 150 slides) Consider splitting projects this large into 

smaller projects.

I bet you’re wondering what “production” means, especially considering the fact that 
most of the projects you create will likely be in the large category (80-150 slides) 
and take you, on average, 10 hours to produce.

Production Does Not Include
To begin, let’s consider what “production” does not include. As mentioned on page 3, 
you’ll need a script and/or storyboard. 

 Storyboards: Rough sketches that show the general content of your 
project, slide by slide. If your projects contain more screen shots of an 
application than captions, a storyboard is a good idea.

 Scripts: Detailed step-by-step procedures. These are ideal if your project 
will contain a significant number of captions.

A typical one-hour eLearning course consists of 12, five-minute lessons. It could take 
at least three hours to write the script (or create the storyboard) for each of those 
lessons. Therefore, you should budget at least 36 hours to write the script for the 
one-hour eLearning course. Depending on how fast you write, you could easily 
double those hours, meaning you may need to budget 80 hours for writing, which 
has nothing at all to do with Captivate production.

Production won’t include creating a Captivate project template, a completed shell 
project that you will use as the basis of all of your projects. It’s not difficult to create 
a template, but it will take time. An ideal template will contain placeholders, an 
introduction slide, transitional slides, a conclusion slide, a skin and appropriate Start 
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and End Properties (while these terms may seem foreign to you now, you will learn 
about many of them as you move through lessons presented in this book).

Finally, production does not include writing, recording or editing the audio 
(voiceovers), making corrections to the script post-rehearsal, resetting the stage 
prior to recording, or recording the lessons using Captivate (the recording time 
should take the exact same amount of time as the process being recorded).

What Does Production Include?
So what’s left? As I mentioned on page 5, it’s going to take 10 hours (on average) to 
produce each Captivate project. What’s included in the production process? 

You’ll spend a lot of time working with text captions. You’ll be adding interactive 
objects (click boxes, buttons and text entry boxes) on several of your slides. 

During the production process, you’ll likely be adding audio clips to the project’s 
background, individual slides and even objects on the slides.

During the production process, you’ll be publishing the project into any one of several 
output formats and possibly uploading those files to a server (LMS) and testing for 
scoring or interactivity errors. After that, you’ll need to fix problems you run across 
(don’t worry, there will be plenty of problems that need to be fixed). After fixing 
those problems, you’ll need to republish, repost and then retest.

Add it all up, and your budget looks something like this (keep in mind that the timing 
below does not include the time it will take to record and edit your own voice-overs 
or narrations):

 40-80 hours to write a script or create the storyboard to support 12, five-
minute lessons for a one-hour course.

 120 hours to edit, produce and test 12, five-minute lessons for a one-hour 
eLearning course.

 40-80 hours to write a narration script to be used by your narrator.

 Up to 100 hours to record and enhance voice narration (much less if you 
use Text to Speech, which I covered in my Essentials book).

So there it is, a mere 400 hours (give or take) is all that stands between you and 
your eLearning course. Are you tired yet? No, not you... and not me. Here’s the deal: 
while creating eLearning lessons in Captivate takes a lot of work (likely more work 
than you thought prior to reading the past few paragraphs), the work will actually be 
fun... and rewarding. I’ve gotten much satisfaction watching students move through 
my eLearning lessons and learning, and had more fun creating the lessons, than just 
about anything I’ve done in my career. I wish the same for you. 
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Resolution and Recording Size
During this module, you will use Adobe Captivate 5 to record a software simulation. 
During the recording process, you will perform several commands on your computer 
and, provided Captivate is running and recording, every click you make with your 
mouse will result in one screen capture (also known as a screen shot).

Prior to recording, you should be aware of two things that control how sharp and how 
large your Captivate screen captures will be: display resolution and recording area.

Display Resolution
A computer monitor is measured in pixels (a pixel is a little square that is the basic 
component of any computer graphic). If a monitor is set to show more pixels, it is 
known as increasing the resolution. At a higher resolution, graphics and text will look 
sharper, but smaller. The fewer pixels you request, the lower the resolution, and the 
larger the screen elements appear.

Consider the following web browser statistics (compiled by www.w3schools.com/
browsers/browsers_stats.asp): First, Mozilla Firefox is currently the most 
popular web browser with just under 47% of the market; Microsoft’s Internet 
Explorer is second at 31%; and the newest entry, Google Chrome, is up and coming 
with just under 17%. Second, the trend in monitor display resolution is trending 
higher. For instance, only 20% of computer users use 1024x768 pixels; the vast 
majority of users use a higher setting.

If your computer is set to a higher resolution (such as 1280x1024) when you record 
screen captures using Adobe Captivate, a customer viewing your published project at 
a lower display resolution (such as 800x600) will have to scroll significantly to see 
the action you recorded.

In contrast, if your computer is set to a lower display resolution (such as 1024x768) 
when you record your lesson, a customer with a higher screen resolution will have no 
trouble viewing your project. However, if you record your projects at too low of a 
screen resolution, you may not be happy with the appearance of the screen icons and 
fonts (they may be too big and not as sharp as they would appear at the higher 
screen resolution). I know what you’re thinking, “So many display resolution 
concerns, so little time!” I’d like to say that display resolution is your only worry. 
Sorry, there’s more. How big of a Recording Area are you going to use?

Recording Area and Types
The Recording Area is not the same thing as Display Resolution (although the two 
settings are constantly confused). The Display Resolution is controlled via your 
computer’s Display settings. 

In contrast, the physical Recording Area is set from within Captivate and is the 
physical amount of the screen that you will be capturing during the recording 
process. There are several preset sizes available within Captivate from 208x176 up 
to 1024x768, and you can specify your own.

With so many choices, what should you do? I recommend that you set your 
computer’s Display Resolution to 1024x768 (so that the appearance of icons and 
screen fonts isn’t too small). In addition, I recommend a Captivate Recording Area of 
no larger than 800x600 if possible (so that your learners do not have to scroll 
excessively as they work through your lesson).
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Generally speaking, Captivate projects consist of slides, similar to Microsoft 
PowerPoint. You can create a blank Captivate project and insert slides, just like 
PowerPoint. If you need pictures of a software application, you can use any one of 
several programs to create screen captures. For instance, I use TechSmith SnagIt 
(www.snagit.com) and Inbit FullShot (www.fullshot.com) all the time. In fact, 
FullShot was used to create most of the screen captures shown throughout this book. 
Any screen captures you create using a screen capture application can easily be 
inserted onto a slide as a background image.

However, most people who create Captivate projects elect to use Captivate to create 
the screen captures. When using Captivate to create the screen captures, there are 
two recording types: Auto Recording and Manual Recording.

When you create projects using the Manual Recording type, you are responsible for 
pressing a specific key on your keyboard each time you want Captivate to create a 
screen capture (the default key is the Print Screen key). The problem with recording 
projects using the Manual Recording method is that you’ll have to be diligent about 
pressing the Print Screen key on your keyboard. You could easily get distracted and 
miss important screens.

If you use Captivate’s Auto Recording type, Captivate automatically captures the 
steps you take on your computer by creating a screen capture every time you click 
your mouse (you can left-click or right-click to get a screen capture). There are four 
capture modes: Demonstration, Assessment Simulation, Training Simulation and 
Custom. I covered all of the modes in my Essentials book. I’ll stick with the Custom 
mode during this module.

Scripts and Rehearsals
As mentioned on page 4, the Write It or script development phase is the most 
important and difficult part of the eLearning development process. After the Write It 
phase, you should rehearse the script to ensure that the script is accurate.

Here’s the scenario: you have been asked to create an eLearning course that will 
teach new employees how to use the free services available at Adobe’s acrobat.com. 
I’ve been using acrobat.com more and more these days. In a word, it’s awesome. 
You can use acrobat.com to store and share documents. You can create and 
collaborate online using documents, tables, and presentations, create PDF files, and 
even host web meetings. Did I mention the best part of acrobat.com? It’s free!

Using Captivate, you have been asked to create an interactive simulation that will 
teach new acrobat.com users how to upload, share and then delete a document. 
Here is an example of the kind of script you might create, or receive from a Subject 
Matter Expert (SME). The text explains, in detail, how to upload a file to acrobat.com 
and then delete it. (Don’t perform the steps outlined below just yet... you will have a 
chance to follow the steps during the student activity on the next page):

Steps to record using Captivate: (Note, these steps assume that 
you have already logged into acrobat.com. You will be uploading 
a PowerPoint file named TCS. That file is among your 
Captivate5BeyondEssentialsData files.)

1. Click the Upload button.

2. Navigate to the Captivate5BeyondEssentialsData folder.

3. Double-click the TCS.pptx file to Open the file and upload 
it.
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4. Click the Share File button located in the lower left of 
the window.

5. Click the Close button.

6. Click the arrow to the right of the TCS.pptx file that you 
just uploaded.

7. Choose the Delete command.

8. Click the OK button.

The script above sounds simple. However, you will not know what kind of trouble 
you are going to get into unless you step through the script prior to recording in 
Captivate. Let’s get started and run a rehearsal now.

Note: You should have downloaded your workbook data files (see 
page vii). Also, if you have not already done so, browse over to 
www.acrobat.com and set up a free account. You will need that 
account for the activities that follow. In addition, acrobat.com figures 
prominently later in this book when you learn how to upload data 
directly into acrobat.com (page 138).

Student Activity: Rehearse a Script
1. Using your web browser, go to www.acrobat.com and log in (if you do not 

have an acrobat.com account, create one now).

2. Upload a file into acrobat.com.

 click the Upload button  

The Select files(s) to upload by acrobat.com dialog box opens.

 navigate to the Captivate5BeyondEssentialsData folder

 double-click the TCS.pptx file to open it and begin the Upload process

3. Share a file.

 with the TCS.pptx file you just uploaded highlighted in the 
Workspace panel, click the Share File button located in the 
lower left of the window 

Note: Don’t click the file to highlight it. If you need to highlight the TCS 
file, use the arrow keys on your keyboard. If you click the file, it will be 
assumed that you want to download the file.
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 select Share it with individuals from the menu that appears

The Share dialog box appears. At this point, all you would need to do is type 
the appropriate email addresses into the People to share with field, type a 
message and click the Share button. For the sake of this example, you are 
simply going to close the dialog box.

 click the Close button

4. Delete an uploaded file.

 click the drop-down menu to the right of the TCS file

 choose the Delete command

 click the OK button to confirm the deletion

Hey, look at that! The script worked perfectly. You are now ready to record the 
steps using Captivate. 
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Student Activity: Edit Captivate’s Preferences
1. Start Adobe Captivate 5 (stay logged in to acrobat.com).

2. Set the Recording Preferences.

 if you are using Windows, choose Edit > Preferences; if you are using a 
Mac, choose Adobe Captivate > Preferences

The Preferences dialog box opens. There are two main categories at the left: 
Global and Recording.

 from the Recording category, select Settings

There are several options available in the Recording area.

 from the Generate Captions In area, ensure that English is selected from 
the drop-down menu

 from the Audio Options area, deselect Narration and Actions in Real 
Time if necessary; leave Camera Sounds selected

 if necessary, select Keystrokes and Hear Keyboard Tap Sounds

The Narration option allows you to record audio at the same time that you 
record the lesson. Because you will not be using audio for the lesson you just 
rehearsed, you won’t need this option. However, this feature could prove 
useful if you are relying on a subject matter expert to record the lesson and 
provide the narration. Instead of creating the lesson and the narration on 
different days, both can be created at the same time. Nevertheless, I typically 
work with professional audio talent and import audio files into my Captivate 
projects later during production (I covered audio at length in my Essentials 
book).

If you select Actions in Real Time, Captivate will set the slide timing for your 
project slides to match the time it took you to complete a process. 
For instance, if you waited 10 seconds from one click to the next, Captivate 
would set your slide timing to match. I typically do not use this feature.

With Camera Sounds selected, you will hear a sound much like a camera 
shutter every time Captivate creates a screen capture.

With Keystrokes selected, Captivate will create a video within your project 
that literally shows what you type, as you’re typing—typos and all. Instead of 
typing during the recording process, I create Text Entry Boxes and allow my 
learners to type text directly into my simulations. Since I typically don’t record 
the process of typing, leaving the Keystrokes option selected does no harm.
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3. Set the Hide options.

 from the Hide area, deselect Recording Window, Task Icon and 
System Tray Icon (Mac users, deselect Recording Window and 
Dock Icon)

Windows Mac 

If you had selected Recording Window, Task Icon (or Dock Icon) and 
System Tray Icon, you would hide all evidence of Captivate during the 
capture process. These items would only get in the way if you were capturing 
your desktop and the Captivate application icon was on the screen. Since I 
tend to create software simulations within specific application windows, I 
typically leave these three options deselected.

4. Ensure that new windows always appear in the Recording Area.

 from the Others area, ensure that Move New Windows Inside 
Recording Area is selected

The Move New Windows Inside Recording Area option could prove useful 
if a pesky window tried to appear outside of your recording area. In that case, 
Captivate would automatically move the window into your Recording Area. 
Without this feature, you would have to pause the movie, drag the window 
into the Recording Area and continue. I typically enable this feature. 

5. Enable Full Motion Recordings (FMR).

 from the Automatically use FMR for area, ensure that both Drag and Drop 
actions and Mouse Wheel Actions are selected

These final two options deal with Full Motion Recordings (FMR). Generally 
speaking, FMRs are useful when you want to demonstrate a complex mouse 
motion. 

During the recording process, clicking your mouse will create a single screen 
shot. However, if you drag your mouse instead of simply clicking, Captivate 
will create a full motion clip (an animation within a slide).
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Student Activity: Set Recording Keys
1. The Preferences dialog box should still be open (Edit > Preferences; or if you 

are using a Mac, Adobe Captivate > Preferences).

2. Reset the key(s) required to Stop Recording.

 from the Recording category, select Keys

 from the lower left of the dialog box, click the 
Restore Defaults button

Observe the keys listed in the To Stop Recording area. This important key is 
what you will need to press on your keyboard when you are finished recording 
the video. If you are using a Mac, consider changing the “To Stop Recording” 
key to [End] so that the instructions used in this book match your system. If 
you cannot find the [End] key on your keyboard (some Mac keyboards simply 
do not have an [End] key), leave the default. However, make a note of the 
keys you will need to press and keep in mind that instructions to stop the 
recording process will be referenced as the [End] key in this book.

 click the OK button

Windows users, hold on tight, you are now ready to record a video. You can 
move to the activity on page 14. Mac users, if you attempt to record a video 
you’ll likely see into a dialog box instructing you to Enable Access for 
Assistive Devices. To avoid the stress of seeing that dialog box just as 
you’re ready to record your first video, let’s enable the feature.

3. Mac users only: Enable access for assistive devices.

 from the Apple menu, choose System Preferences

 from the System group, double-click the Universal Access 
button

The Universal Access window opens.

 select Enable access for assistive devices

 close the Universal Access window

Enabling access for assistive devices is something that you will only have to do 
once. You are now ready to record your first video. Go ahead and return to 
Adobe Captivate (if necessary).
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Custom Recordings
You can create software demonstrations or simulations using Captivate. Typical 
demonstrations include text captions that explain what’s about to happen, and then a 
mouse automatically moves across the screen to perform the action. 

With a simulation, you can have a text caption explaining the concept, just like a 
demonstration, but you can include interactive hotspots (click boxes) that will let the 
user actually perform the required steps. 

Between demonstrations and simulations, I recommend you create simulations, 
especially if you are working by yourself and don’t have the resources to create both 
a demonstration and simulation for the same lesson. Why are simulations better? It’s 
always better to let a user perform the step-by-step process you’re trying to teach 
instead of allowing them to passively watch the steps.

When recording, I recommend you use Captivate’s Custom recording mode. This 
mode effectively combines Captivate’s Demonstration and Simulation modes. Using 
the Custom recording mode when you record, Captivate will automatically add text 
captions and click boxes throughout the lesson that will engage your learner.

Student Activity: Record a Custom Simulation
1. Record the custom simulation.

 from the Create New area of the Welcome screen, click 
Software Simulation (or choose File > Record new project)

 from the top of the control panel, select Application

 from the drop-down menu that appears beneath Application, 
select Adobe Acrobat.com window

2. Specify a recording size.

 from the Snap to area, select Custom Size

 from the next drop-down menu, select 800 x 600

3. Select a Recording Mode.

 from the Recording Type area of the Control panel, select Automatic 
(if necessary)

 select Custom from the list of modes and ensure that the remaining three 
modes are deselected
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4. Disable Panning and Audio Narration.

 ensure that Panning is set to No Panning and that Audio is set to 
No Narration

5. Set the Custom mode recording options.

 click the Settings button

 from the Recording Modes, Mode drop-down menu, select Custom

 click the Restore Defaults button at the bottom of the dialog box

 from the Captions area, select Add Text Captions

 from the Click Boxes area, select Add Click Boxes on Mouse Click

 select Failure Caption

You have selected Add Text Captions so that the captions will be created for 
you. Nice. And, since the captions are written in the active voice, you may be 
able to use them in the new lesson with little editing. Nicer. Everything else 
has been left deselected except for Click Boxes and Failure Caption. As a 
result, this will be a highly interactive simulation. Nicest!

 click the OK button
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6. Record the Custom simulation.

 click the Record button and, once the Countdown goes away, click the 
Upload button in the acrobat.com window

 navigate to the Captivate5BeyondEssentialsData folder

 double-click the TCS.pptx file to open it and begin the Upload process

 with the TCS.pptx file you just uploaded selected in the Workspace panel, 
click the Share File button located in the lower left of the window 

 select Share it with individuals from the menu that appears

 click the Close button

 click the drop-down menu to the right of the TCS file

 choose the Delete command

 click the OK button to confirm the deletion

7. Stop the recording by pressing [End] on your keyboard (the default for 
stopping the recording process on the Mac is [Command] [Enter]... not to be 
confused with [Command] [Return]).

Note: If you can’t get Captivate to stop recording via your keyboard 
shortcut, you can always manually stop the recording process by 
clicking the Captivate icon in the System Tray (Windows users) or the 
Dock (Mac users).

8. Save the project to the Captivate5BeyondEssentialsData folder as 
UploadToAcrobat.

9. Preview the project. (File > Preview > Project)

As you move through the lesson, notice that there are Text Captions (they are 
not perfect and will need editing, but they’ve been added for you just the 
same). Also notice that there are Click Boxes (hot spots) in the correct place 
that make this lesson 100 percent interactive.

10. When finished previewing the lesson, close the preview and then save and 
close the project.
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Confidence Check
You have been asked to bookmark the acrobat.com web site so it 
can be accessed quickly in the future. The process of creating a 
bookmark (a Favorite) varies depending on the browser you are 
using. For instance, if you are using Internet Explorer, you 
could choose the Favorites menu, click the Add to Favorites 
button and then click the Add button. If you are using Google 
Chrome, you could click the Bookmark button and then click 
the Add button. In Firefox, you could choose Bookmarks > 
Bookmark This Page. And finally, Mac users running Safari 
could show the Menu bar and then choose Bookmarks > Add 
Bookmark, and then click the Add button.

1. Using your browser of choice, use the Custom recording mode to create a 
video that simulates the process of creating a Bookmark (Favorite) for 
acrobat.com.

Not sure how to proceed or what exactly to record? Use Captivate to open the 
project named Bookmarking.cptx (you can find it within the 
Captivate5BeyondEssentialsData folder). Preview the project and you’ll see 
that I’ve created a video of the bookmarking process in each of the browsers 
mentioned above. You need to do the same in any browser you want.

2. When finished recording, save the new project to the 
Captivate5BeyondEssentialsData folder as CreateFavorite.

3. Preview the project.

Notice that there are text captions and interactivity, which is wonderful. 
However, none of the captions contain end of sentence punctuation. While I 
am personally not a fan of end of sentence punctuation, many corporate style 
guides insist on end of sentence punctuation. 

Believe it or not, it is possible to “pre-edit” the text captions and change, 
among other things, the text that actually appears in the captions and how 
Captivate treats end of sentence punctuation. You’ll delve into that next. This 
little bit of wizardry just might save additional hours of editing down the road.
© 1994-2010, IconLogic, Inc. All Rights Reserved. 17



Adobe Captivate 5: Beyond the Essentials
Text Caption Pre-Editing
As you have just seen when you recorded a lesson using the Custom mode, 
Captivate created the text captions for you. Those captions were written in the active 
voice, which was great. However, there are a couple of ways to write an instruction. 
For instance, if you want to instruct a user to select the New command from a menu, 
here is how the instruction could be written:

1. Select the New menu item. 

2. Choose the New command. 

If you elected to go with the first option, you would be done because that’s the 
way Captivate automatically writes instructions when it creates the text captions. 
However, if you wanted to update the text caption to reflect the second option, 
you'd have to make the change manually. While not difficult, this kind of editing 
is very labor-intensive. And as I mentioned on the previous page, end of sentence 
punctuation is a debatable topic. Do you or don’t you? I don’t, but you might not 
agree.

To save a significant amount of text editing during post-production, you pre-edit the 
text captions by editing one of the CaptureTextTemplates files that are stored in the 
Captivate application folder on your hard drive. Captivate uses these files during the 
recording process when it creates the text captions.

Student Activity: Edit a Text Capture Template
1. Exit (Quit) Captivate.

2. Locate the file that controls the text that appears in automatic text captions.

 navigate to the folder where Adobe Captivate 5 has been installed on 
your computer (typically [InstallDirectory]/Adobe/Adobe Captivate 5)

 find (but do not open) CaptureTextTemplates_English.rdl file

Note: During the next step, you will be copying the rdl file to the 
clipboard and then pasting it into the folder. You must have read/write 
privileges to the folder before you can paste or alter the file. 

3. Make a backup copy of the CaptureTextTemplates_English.rdl file.

This is possibly the most important step—if you make a mistake in the 
CaptureTextTemplates_English.rdl file during the steps that follow, you 
could always replace the original file with the copy (using the name of 
the original file).

 Windows users, select the CaptureTextTemplates_English.rdl file and 
then copy and paste it into the Captivate 5 folder; Mac users, duplicate 
the rdl file instead of copying and pasting

The name of the copied/duplicated 
RDL file will vary between Windows 
XP, Vista, Windows 7 and the Mac 
OS. The image at the left is the file 
as it appears in Vista.
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4. Open CaptureTextTemplates_English.rdl with NotePad (Windows) or 
TextEdit (Mac).

 Windows users: right-click the CaptureTextTemplates_English.rdl file 
and choose Open; Mac users, double-click the file

If the file does not open in NotePad (Windows) or TextEdit (Mac) by itself, you 
may need to lend a helping hand.

 Windows users: if a “Windows cannot open this file” dialog box (or similar) 
appears, select Select a program from a list of installed programs and 
then click the OK button; Mac users, select Choose Application

The Open With dialog box will appear.

 Windows users, select Notepad from the list of available programs and 
click OK; Mac users, select TextEdit

The file will open in your text editor. If you are familiar with programming 
languages like HTML or XML, you will likely recognize the tags used in the 
document. If you do not have programming experience, no worries, you will 
be able to edit the template either way.
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5. Edit the template.

 scroll down to the part of the document shown below (if you have trouble 
finding the text, use the Find feature available in both Notepad and 
TextEdit to find Object Name=”Menu”)

This is the part of the document that controls the words “Select” and “menu 
item.” If you edit the text in this part of the template, the automatic text 
captions created during the recording process will allow you to skip much of 
the editing process during the post-production phase. For instance, if you 
wanted the word “Choose” to appear in the text captions instead of “Select,” 
you’d need only change the word “Select” to “Choose.” And if you want each 
of the text captions to end with a period, all you’d need to do is add a period 
just to the left of the closing quote.

 click between the “u” in “menu” and the closing quote

 type a period
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Confidence Check
1. In the image below, I’ve added periods to the end of 

several lines of text. Spend a few moments adding periods 
on your own.

2. As an experiment, change the words Select the %s menu item to 
Choose the %s command. 

3. Save and close the text file. 

Note: Depending on your folder access privileges, you might run into 
trouble when trying to save the text file. If you have admin rights to the 
folder and are unable to save, try first saving the file to your desktop 
and then copying the file into the Adobe Captivate 5 folder.

4. Return to Captivate.

5. Using your browser of choice, use the Custom recording mode to create 
another video that simulates the process of creating a Bookmark (Favorite) for 
acrobat.com.

6. When finished recording, save the new project to the 
Captivate5BeyondEssentialsData folder as 
CreateFavorite_CustomCaptions.

7. Preview the project.

The text captions should now contain end of sentence punctuation. In 
addition, if you used a menu when creating the Favorite, the text in the 
captions where you selected a menu command should now begin with 
“Choose” instead of “Select” and end with “command” instead of “menu item.” 

Note: You can restore any changes you have made to the rdl file easily. 
Close Captivate. Delete the original rdl file that you edited (the one 
named CaptureTextTemplates_English.rdl). You should still have 
your backup rdl file. Simply rename the backup rdl file as  
CaptureTextTemplates_English.rdl and then restart Captivate.
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